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 SolidWorks 2½D Parts 
IDeATe Laser Micro Part 1b 

Dave Touretzky and Susan Finger 

1. Create a new part  
In this lab, you’ll create a CAD model of the 2 ½ D key fob below to make on the laser cutter. 

 

 

Select File → New → Templates → IPSpart 

If the SolidWorks Resources fly-out menu is visible on the right side, click in empty space in the 
graphics window to collapse it. Also, select the Features tab. If Instant3D is highlighted as it is in 
the screen capture below: 

 

Then deselect it so it is Off. 

1.1 Create the base 

To create the base of the key fob, we will first create a rectangle. In the left hand menu, select the 
front plane.  
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If your view looks like the one above, use the View Orientation tool to get to the Front view: 

 

The toolbar shows the 3D workspace and lets you select your viewpoint. If you think of the 
workspace as a box, for most of this lab, we will be standing in front of the box looking in. 
Another common view used by architects and civil engineers is the top view, in which you look 
down from the top at the bottom of the box. 

 

Next, select the Sketch tool bar. 

 

Select the corner rectangle tool. Note the many different types of rectangle tools available; stick 
with the default for now. 
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Move mouse around and note snap-to lines above or beside the origin. Click your mouse above 
and to the right of the origin, then drag to create a rectangle about 3” wide and 1” tall. Note the 
cursor readout as you move the mouse. 

 

After you click the mouse for the second point, the rectangle tool is still active. (The button is 
highlighted in the toolbar.) To confirm that the rectangle is correct, click the green checkmark 
near the top of the left-hand panel. (In this lab, “click OK” and “click the green checkmark are 
equivalent.”) 

 

Next, to make the hole in the tag, click on the polygon tool.  
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Note that once you have selected the polygon tool you can change the parameters in the boxes on 
the left of the SolidWorks window. For now, the defaults are fine. 

 

Draw a hexagon that is entirely within the rectangle. Note that your first mouse click is the center 
of the polygon. Also, notice the snap-to lines as you move the mouse.  

 

If you are happy with your polygon and want to make more polygons, click the green checkmark 
in the left-hand panel. This will accept the parameters of the current polygon and will keep the 
polygon tool active so you can make more polygons. When you are done making polygons, you 
can press Enter or Esc to exit the Polygon tool. Finally, Exit Sketch to get back to the main 
SolidWorks screen. 
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1.2 Extrude the base 

Next we will extrude the sketch to make it into a 3D part. Extruding is a common manufacturing 
process in which material is pushed through die to give it a constant cross section. For example, 
squeezing a tube a toothpaste extrudes the paste into a cylinder with a constant diameter. 
Extruded parts are often called 2 1/2D because their cross section is always the same. 

To extrude the sketch, first select it in the part menu in the left panel:  

 

Click on the Features toolbar and select the Extruded Boss/Base tool. 

 

You will get a new window on the left side in which you can change the parameters of the 
extrusion. Set the depth (the box labeled D) to 1/8 in, which matches the depth of the acrylic we 
will be using. Note that I entered 1/8” and SolidWorks converted it to 0.125 in. 
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If the part looks good, click the green checkmark. If you made a mistake, click the red X and 
redo the extrusion. 

 

To get back to the front view, click on the View Orientation tool and select the front view. 

1.3 Navigating in SolidWorks  
 
SolidWorks uses the standard Windows keyboard shortcuts and mouse gestures. Learning and 
using these short cuts can save time. Typing ctrl-c ctrl-v is much faster than right clicking, 
finding and selecting copy, then right clicking, finding and selecting paste. Plus, it works in all 
Windows application. 
 

Ctrl-a select all 
Ctrl-c copy 
Ctrl-n new file 
Ctrl-o open file 
Ctrl-p print 
Ctrl-r redraw 
Ctrl-s save file 
Ctrl-v paste 
Ctrl-w close file 
Ctrl-x cut 
Ctrl-y redo 
Ctrl-z undo 
del delete 
left click select 
shift left click multiple select 
right click  context sensitive menu 
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Here are some specialized SolidWorks shortcuts to help you navigate in SolidWorks: 
 

f fit part to window 
scroll wheel zoom 
Ctrl middle button translate 
middle button rotate about screen x and screen y 
Alt middle button rotate about screen z 
left click on an entity context sensitive tool bar 
right click on an entity context sensitive tool bar plus menu 
left click on background deselect 
Esc exit current mode 
space bar show views orientation menu 

 
If you scroll so your part is out of view, the easiest way to get it back is to type "f" to fit the part 
in the window. You can also right click and select Zoom to Fit. 

To switch back to Sketch mode, you can bring up the context sensitive menu by:  

1. Left clicking on a face, or 

2. Left clicking on the feature in the Feature Manager tree, or 

3. Opening the Feature (click on the arrow) Feature Tree Manager and clicking on the 
sketch icon that appears below it.  

 

In the screen shot above, I clicked on the face of the part and am about to select the Edit Sketch 
icon from the popup menu. This puts me back in Sketch mode. 

1.4 Feature Manager Tree 
In the screen shot above, you can see the Feature Manger Tree on the left hand side. The root of 
the tree is the part name. Yours is probably Part1; mine is Part3 because I created several parts 
while working on this tutorial. Note that the Feature Tree includes the History, Annotations, 
Material, etc. If you click the arrow next to Boss Extrude, you can see that the feature was 
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created from Sketch1. Once you start to create more complicated parts, the Feature Tree will 
help you select and modify different elements of your design. 
 

1.5 Modifying a toolbar 
Because you will often want to execute the Front View command after you have been rotating 
and scrolling around in SolidWorks, we will add the Front View icon to the Sketch toolbar. You 
can use this same procedure to modify any of the toolbars to include the commands you use most 
often. This is particularly useful if you install SolidWorks on your personal computer. 

1. Right click on a blank spot in the Sketch toolbar. You should get the context menu below. 

2. Click on Customize.  

 

3. Select the Commands tab in the popup window, then click on Standard Views.  
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4. Click and drag the Front View icon into the Sketch toolbar.  

 

5. Click OK to close the Customize window. You should see the Front View icon in your 
Sketch toolbar now. 

Remember you can press the space bar to select other views. 

1.6 Editing relationships (if only it were so easy)  

The ability to add constraints and relationships in SolidWorks is one of its most powerful 
features. SolidWorks is a parametric modeler which means that parts can be defined by equations 
as well as dimensions. For example, you can say that one side of a rectangle is twice the length 
of the other side. If you redimension one side, the other one will change too. 

If you are not already in Sketch mode, right click on a face and select the Edit Sketch icon. 
Then, to be sure your planes are aligned with the axes, click the Front View icon. 

In the screen shots below, I have a view that show the relationships among the entities. This 
makes the window a little messy, but it’s useful when you are first learning how SolidWorks 
uses relationships. Go to View → Hide/Show. Select Sketch Relations from the menu. Hover 
your mouse over a few of the green icons to see the relationships. Sometimes when SolidWorks 
tells you that your part is over- or under-defined, displaying the relationship icons can help you 
figure out what the problem is.  

In the left-hand panel, select the Property Manager tab, then select the right vertical line in your 
part: 
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Notice that the line has a vertical constraint. Also notice that there is a notification icon that tells 
us that the part is Under Defined. More on this later. 

In the submenu titled Existing Relations, select the Vertical relation, right click, and delete it. 
Grab the top right point and drag it to the right; now you have a quadrilateral instead of a 
rectangle. 

 

Type ctrl-z to undo the drag operation. You will have a rectangle again. Type ctrl-z a second 
time to restore the vertical constraint. You should see the Vertical relation reappear as an 
Existing Relation. Now drag the same point to the right. Because the line is constrained to be 
vertical, you can resize the rectangle, but you can’t change the right angles. 

Type ctrl-y twice to redo both operations. Type ctrl-z twice to undo both operations.  

Click on some of the other lines in your part drawing to see the relationships that SolidWorks 
creates for you. The lines and points in the hexagon are particularly interesting.  

Before you finish this part of the tutorial, be sure your part is a rectangle, but without the vertical 
constraint on the right-hand line: 
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Exit sketch mode by clicking on the Exit Sketch icon. 

1.7 Adding fillets 

Rotate the part so you can see the corner edges.  (Press the scroll button and move the mouse.) 

 

Switch to the Features tab. Click on the top right edge and select the Fillet tool. A fillet is used 
to create a smooth, rounded transition between two surfaces.  

 

Set fillet radius to 0.05 in and press enter. Check the Features tree to see how your part has 
changed. 
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Add a fillet on the bottom left edge. Click the green checkmark to accept. Note that when you 
click on a line that can be filleted, you get a popup tool bar that includes the fillet icon. Also, 
once you set the value of the radius for the fillet, the new value becomes the default. 

After you have created both fillets, you can get back to the regular view by selecting the Front 
View from the Standard Views icon: 

 

Look in the Feature Manager tree to see Extrude and Fillet features. If you click on Fillet1, 
SolidWorks will highlight that feature in the drawing. Create two more fillet feature for the top 
left and bottom right corners; this time, set the radius of each to 0.5 in.  

 

1.8 Changing appearances 

Click on a face and click the Appearances (beach ball with a pencil) icon. In the Appearances 
pop-up menu, click on the part name (probably Part1). The left window gives you the options for 
Appearance. At the bottom of the window, select a color. 
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While you have the Appearance tool open, look at the different options that you can change. For 
now, just select a color from the palette and click OK.   

1.9 Rollback 

SolidWorks has a useful feature called the Rollback Bar. The rollback bar appears as a thick blue 
line in the Feature Manager. (The numbers of my fillets is probably different from yours because 
I was doing lots of experiments while I was writing this handout.) 

 

If you hover the mouse over the rollback bar, your mouse will change to a hand with which you 
can grab and move the bar. Grab the rollback bar and roll back the last two fillets. Grab the bar 
again and pull it down to bring back the fillets. 

1.10 Dimensioning 

Go back into Edit Sketch mode. I find the easiest way is to click on a face and select the Edit 
Sketch icon. Note that you sketch does not show the fillets, but they still appear in the feature 
tree. 

Click on the Smart Dimension tool in the Sketch toolbar. Select the left vertical line of your key 
fob and set its length to 1 inch by entering the value in Parameter box toward the bottom of the 
left-hand panel. Remember to click the green check mark to confirm.  
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1. Select the bottom horizontal line and set its length to 3 inches.   
2. Select the circle inside the hexagon and set its diameter to 0.6 inches. Note that you can 

enter arithmetic expressions in the parameter boxes in SolidWorks. So you can set the 
radius to 6.0/2. 

3. Press shift, then first select the right line and then the top line. Set their angle to 75 deg. If 
the angle is going the way, click on the arrow next to the value for the degrees in the left 
hand panel. 

 

Notes: If the vertical constraint is still active, the step 3 will not work because your part is over 
constrained. Also, if you get the angle backwards (which I did the first time I did this), the value 
for the angle has two arrows next to it. Just click and the angle will be reversed. 
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Note that you can click on any smart dimension to bring up the dialog box that lets you change 
the value. 

Hit Escape to exit the Smart Dimension tool.  

1.11 Modifying relationships and dimensions  
1.11.1 Changing more relationships  

For this section, you should be in Sketch mode in the Front View. 

1. Click on the left vertical line to select it; observe the Line Properties.  
2. Shift-click on the right vertical line; now two lines are selected.  
3. Click on the Equal relation in the lower part of the left-hand panel 

 

4. You should get an error message The problem is that the part is inconsistent. The left line 
has a vertical constraint. The two lines can’t be the same length unless they are both 
vertical. We need to remove the vertical constraint on the left line. 

5. Click on the left vertical line.  
6. Click on its Vertical property, right click, and delete it. 
7. Shift click on the right line to select both lines. Click on the equality constraint. 
8. Click OK to accept the sketch. Looks nice!  
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9. Drag the bottom left point to the origin, which is indicated by the red arrows. Notice that 
the parallelogram has turned black. No lines are draggable. The parallelogram is now 
fully defined 

 

10. Click on the plus sign at the center of the hexagon and drag it back inside the 
parallelogram.  

11. Click on the top line of the hexagon. Add the Horizontal property by clicking on it. This 
rotates the hexagon so the top line is parallel to the x-axis. 

 

1.11.2 Changing more dimensions 
While you are still in Sketch mode, click on the Smart Dimension tool.  
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1. Click on the point at the center of the hexagon, then on the bottom line of the key fob. 
Click on the dimension to get the edit box. Set the distance to 0.48 inches.  

 

2. Click the green checkmark and hit escape to exit.  
3. Click on the Smart Dimension tool again. Click on the point at the center of the hexagon 

again, then click on the origin. Slide the mouse around and watch the dimension type 
change.  

4. Bring the mouse between the two points and well above or below them to get a horizontal 
dimension. Click on the dimension and set it to 0.6. Click the green checkmark and hit 
enter to exit dimensioning. 

 

Now the sketch is fully defined. Click Exit Sketch. Select File → Save As and save your part as 
andrewID_KeyFob.SLDPRT, using your andrewid as part of the filename. 

1.12 Adding key fob holes 

Edit the sketch again. Use the Circle tool, which is in the Sketch toolbar, to make a small circle 
in the bottom left corner of your part. The default is that the first mouse click defines the center 
of the circle; the second mouse click sets the radius. The circle tool has a second option that lets 
you define a circle by selecting 3 points, but we won’t be using that tool in this tutorial. 
Dimension this circle to have a diameter of 0.125 inches. If you’ve forgotten how to set a 
dimension, go back to the earlier section.  



 

18  

 

Make another circle in the top right corner of the object. Press Enter to exit the circle tool. Click 
on the first circle, shift click on the second, and make them Equal. Be sure to select the circles 
and not the center points. 

 

Use the Smart Dimension tool to set the diagonal distance between the center of the bottom 
circle and the origin to 0.25 inches. Remember that as you move your mouse around you can set 
the horizontal, vertical or diagonal distance. In the screen shot below, you can just see the lines 
that show I am setting a diagonal distance. 

 

Click the green checkmark and press Enter to exit dimensioning. 
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Click and drag on the center of the circle and note that it is constrained to move along an arc. 
Position it as symmetrically as you can.  

Smart dimension the top circle to a diagonal distance of 0.25 inches from the top right corner. 
Exit the sketch to see the hole placement. 

1.13 Adding text 
The last step is to add your name to the key fob. Your name will be cut into the key fob as if it 
were an extrusion. Normally, you think of extrusions as pulling material out of the part. To 
create the text, the letters will be extrusions that go into the part. To do this, we will start the 
Extruded Cut command, use the Sketch tools to write the text, then finish the Extruded Cut 
command. That is, everything we create between starting and ending the Extruded Cut command 
will be extruded together. 
 
In the Features toolbar, select Extruded Cut. This step starts the definition of what will be 
extruded: 

 

1. Click on the front face of the part and select a normal view.  
2. Select the Sketch toolbar and click on the text tool (capital "A").  
3. Click where you want to place your text (you won't see anything yet).  
4. Type your name in the text box in the left-hand panel. Then click the green check box. 

 

You should see a small blue dot at the bottom left corner of your text. Click and drag the dot to 
position the text.  

1. Double click on the text to re-open the text dialog box.  
2. Uncheck "Use document font."  
3. Click the Font button, and select a font you like.  
4. Switch the font size to Points and select the size you want.  
5. Click the green checkmark to exit the text dialog. Click on Exit Sketch.  

In the Extruded Cut dialog, set the cut depth to 0.01 inches and click the green checkmark.  
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In the Feature Manager tree, click on the Cut-Extrude feature, select the beach ball, and color 
the feature (not the entire part) orange. Save your part again. 
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